This chapter shows how to simulate various amplifier measurements for both low noise and power amplifiers.

Lab 11: Amplifier Simulations

OBJECTIVES
• Perform a variety of amplifier measurements using HB and CE

About this lab: In Part 1 you will modify the mixer to become a 900 MHz amplifier, matching the output, checking stability, and simulating ACPR. In Part 2, you will obtain a FET from library and use the example Load Pull files.

PROCEDURE (part 1): amplifier stability and ACPR

1. Create a new project, copy two designs into it, and modify it

The next steps show how to copy specific designs (with sub-circuits) into a new project. This means moving all the desired hierarchy because you cannot simulate with part of the design in another project.

   a. In the Main window, create a new project named: **amplifier**.

   b. Go back to the mixer project and open the schematic: **ckt_env_mixer**. Now, click: **Save As** and save the schematic in the **networks** directory of the new amplifier project, giving it the name: **amp_LNA**.

   ![Save As dialog](image)

   c. Now, push into the bjt_pkg circuit in the new schematic amp_LNA. Save it with the same name (bjt_pkg) in the amplifier project as you just did in the last step.

   d. Close all the open schematic and data display windows (saving where appropriate). Go back to the Main window and open the Amplifier project and open the amp_LNA schematic and push into the bjt_pkg to be sure it is OK and pop out. If you have any problems, check your previous steps.
e. At this point, the circuit will be modified to become an amplifier. It will also require making another set of S-parameter measurements for matching the output to 900Hz. Refer to the existing circuit and modify it as follows:

- Remove the LO and replace it with a 50 ohm resistor
- Replace the RF source with a Term where Num=1, and be sure the Vout port is Num=2.
- Insert an S-parameter controller setting freq: 100 MHz to 2 GHz in 10 MHz steps.
- Delete the envelope controller and the associated VAR equations.
Lab 11: Amplifier Simulations

f. Run the simulation and plot the S-parameters in a new data display as shown. S11 and S22 are on a Smith chart with markers at 900 MHz and S21 and 12 are plotted on a rectangular plot to verify their values. Note the marker text (Smith) is edited to Zo or 50 ohms.

Design Note: The S11 and S21 measurements look good at 900 MHz. But the output match S22 is capacitive and adding a series inductor is a reasonable approach. In addition, amplifier stability can be a problem if there is any feedback such as Cjc (collector to base capacitance) and will have to be checked.

2. Add a series L, then tune the output match

At 900 MHz, S22 is capacitive and a series inductor is a good approximation to move to the center.

a. Be sure the markers are at 900 MHz and insert a series inductor at the input.

b. Select the inductor and tune it as close to the center of the Smith chart as possible, making sure that S21 remains better than 15 dB and S11 also remains near its present value.

Design Note: Tuning the output match should also improve the S21 (gain) at 900 MHz. Also, it is not necessary that you get the same value as others in the class. It is only necessary that your values be close.
3. Create the sub-circuit

In this step, you set up the circuit like an IC where connections are represented as pins and no controllers are in the schematic.

a. Set up the circuit as shown: 1) remove the Vcc power supply and replace it with a port connector (Num=3), and 2) connect the grounds where shown, wire them together, and insert another port (Num = 4).

b. Rename the port names: P1 becomes RF_in, P2 becomes RF_out, P3, becomes Vcc, and P4 becomes Gnd as shown. When completed, the circuit should look like the one shown here where the matching inductor is 26.5 nH – use this value for the remainder of this section.

c. Create the symbol: click View > Create/Edit Schematic Symbol. When the dialog appears, click OK and the symbol will automatically appear.
d. When the symbol appears, you may have to move the names and position them near the pins by carefully selecting or rubber banding them with the cursor as shown here. You can also use the Draw > Polygon command to create an amplifier block symbol. If you make a mistake, use the undo command (arrow) or select all, delete, return to the schematic and start again.

e. When finished, return to the schematic: View > Create/Edit Schematic. Be sure to save the schematic when complete.

f. Optional – click File > Design Parameters and type in a description in the General tab such as: 900 MHz amplifier.

g. Clean up your network directory by removing the unwanted schematic that you copied from the mixer design – this is good practice. Use the windows explorer or file manager and delete all ckt_env_mixer files from the amplifier project only.

4. **Create a new schematic for basic LNA testing**

a. In amplifier_prj, open a new schematic and save it as LNA_basic.

b. Insert the amp_LNA into the schematic and push into it and the bjt_pkg to verify the 3 hierarchical levels to this circuit.
5. S-parameter simulations: gain circle, noise circle, and stability

The following step will provide you with gain circles, stability factor and regions, $\mu$ (load stability) and $\mu_{\text{prime}}$ (source stability). To get these values, you will set up an S-parameter simulation and use equations.

a. Set up the schematic as shown for a swept S-parameter simulation with noise turned on (you will need this for noise circle in another step).

b. Insert measurement equations: $\text{Mu}$, $\text{MuPrm}$, and $\text{GaCir}$ from the S-parameter palette. Note the gain circle equation must be set to the value of desired gain in dB = 25, and use the default number of points = 51. Also, set $\text{Vcc} = 3.0$ volts for this circuit.

c. Set up a dataset name: LNA_sparms.

d. Simulate. When the simulation is finished, go to the data display and change the default dataset to LNA_sparms.

**Note on default data:** Notice that the existing 2 plots may look different. This is because the previous default dataset contained simulation results prior to adding the inductor at the output to match for 900 MHz. Now, these plots show the new data and you may have to move the markers to remove the invalid annotation.
In the data display, insert a Smith chart of the gain circle equation data. Put a marker on the circle as shown here. Each circle, regardless of its size, represents a frequency in the simulation. For this circle, the gain will be 25 dB or greater at 900 MHz for any source impedance within the circle. Put a marker on the next circle and the same is true for that frequency.

Insert a rectangular plot of \( \mu \) and \( \mu' \). As shown here, the marker on \( \mu \) indicates the distance from the center of the Smith chart to the nearest output load stability circle.

The \( \mu' \) trace is for the source stability circle. In general, \( \mu \) and \( \mu' \) must be greater than 1 for stability. Values less than 1 indicate instability. The greater the value, the greater the stability at that frequency.

Insert two equations and plot them as shown. The argument in each is the complete S-parameter matrix. Notice that the stability factor \( k \) is best at 300 MHz for all 4 S-parameters. The stability region shows all the frequencies are outside the circle for source stability. If inside, then the circuit is unstable.

\[
\text{Eqn: } S_{\text{Factor}} = \text{stab_fact}(S)
\]

\[
\text{Eqn: } S_{\text{Region}} = \text{s_stab_region}(S)
\]

\[
\text{ freq } | S_{\text{Region}}
\]

\[
\begin{array}{|c|c|}
\hline
\text{freq} & S_{\text{Region}} \\
\hline
300.0 \text{MHz} & \text{Outside} \\
400.0 \text{MHz} & \text{Outside} \\
500.0 \text{MHz} & \text{Outside} \\
600.0 \text{MHz} & \text{Outside} \\
700.0 \text{MHz} & \text{Outside} \\
800.0 \text{MHz} & \text{Outside} \\
900.0 \text{MHz} & \text{Outside} \\
1,000.0 \text{MHz} & \text{Outside} \\
1,100.0 \text{MHz} & \text{Outside} \\
1,200.0 \text{MHz} & \text{Outside} \\
1,300.0 \text{MHz} & \text{Outside} \\
1,400.0 \text{MHz} & \text{Outside} \\
\hline
\end{array}
\]
h. Insert a list and add: nf(2), Nfmin, and Sopt which were generated from the simulation. Scroll to the 900 MHz values so you can read them.

<table>
<thead>
<tr>
<th>freq</th>
<th>nf(2)</th>
<th>Nfmin</th>
<th>Sopt</th>
</tr>
</thead>
<tbody>
<tr>
<td>900.0MHz</td>
<td>3.157</td>
<td>0.982</td>
<td>0.800 / 34.559</td>
</tr>
</tbody>
</table>

i. In the data display, insert an equation as shown:

\[
\text{Eqn } \text{my}_\text{ns}=\text{ns}_\text{circle}(\text{nf}_2, \text{Nf}_\text{min}, \text{Sopt}, \text{Rn}/50, 51)
\]

Note that Rn/50 is the noise resistance (sensitivity of the noise figure to the source impedance) where 50 ohms is the system impedance. Also, 51 is the number of points.

j. Go back to the schematic and reset the simulator to a single point at 900 MHz. Simulate again and insert a Smith chart with the equation my.ns. You will see the noise circle for the value of nf2.

k. In the equation, change nf2 to the value of 1 (a lower noise figure). You will see the new circle. If you were to plot a gain circle on this same chart, you could then compare the values and determine which source impedance would be preferable (trade-off).
6. **Set up a swept input power simulation using a P_nHarm source**
   
a. Save the last schematic as: LNA_hb.

b. Modify to schematic to look like the one shown here:
   
   - Add the variable Pavs to the VAR – this will be available source power.
   - Insert a P_nHarm source (each P[n] is the power in that harmonic)
   - Insert a HB controller set as shown where you will sweep Pavs.
   - Also, insert a current probe as shown.

---

**HARMONIC BALANCE**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Harmonic Balance</td>
<td>HB1</td>
</tr>
<tr>
<td>MaxOrder</td>
<td>4</td>
</tr>
<tr>
<td>Freq[1]</td>
<td>RF_freq</td>
</tr>
<tr>
<td>Order[1]</td>
<td>3</td>
</tr>
<tr>
<td>UseKrylov</td>
<td>yes</td>
</tr>
<tr>
<td>SweepVars=Pavs</td>
<td></td>
</tr>
<tr>
<td>Start</td>
<td>40</td>
</tr>
<tr>
<td>Stop</td>
<td>0</td>
</tr>
<tr>
<td>Step</td>
<td>2</td>
</tr>
</tbody>
</table>

---

```verbatim
VAR freq_and_V_vars
Vcc=3.0 V
Pavs=-10
RF_freq=900 MHz
```
c. Simulate and plot all three of the swept harmonics at Vin and Vload on the same plot using the dialog box – you will have to select Vin and Vload three times each.

You should see a plot of all 3 tones swept over the Pavs range minus any difference in the source settings. Here, the 3rd harmonic is interesting. Its input power is less than the output power until Pavs = -30 which is actually -65.459 as shown by the marker.

```
m1
Pavs=30.000
d3(Vin[.3])=-55.459
```

![Plot of swept harmonics with marker indicating input power is less than output power until Pavs = -30]


d. Insert a new plot and add the Time domain signals for Vin and Vload. As shown here, you can also look at the swept waveforms in the time domain where the ts function is used to transform the HB data. Note the appearance of a slight delay through the amplifier.

![Plot of time domain signals with time delay]

e. Save the schematic and data display.
7. Set up a Multi-Harmonic Load Tuner using 2-tone HB simulation

This part of the lab uses the LNA but the simulations are applicable to power amplifiers. This step will require writing equations to vary the load and source for different harmonics and will take longer than other labs to set up the simulation and data display. However, the results that you achieve will be very powerful for designing amplifiers. Also, this will help you to use the more powerful example files such as ACPR and load-pull.

a. Save the previous schematic with a new name: **LNA_2tone**.

b. Modify the schematic to look like the one shown here:

- Insert two S1P_Eqns (Eqn Based Linear palette) and set them as shown.
- Insert a VAR for source_tuner as shown (load tuner will be defined later).
- Insert a current probe for Icc.
- Edit the VAR as shown by setting Vcc=3 V, spacing = 50 kHz, and RF_freq = 900 MHz, and Pavs = -20. **Pavs is available source power.**
- Use a V_nTone source set up as shown with 2 tones and spacing. **The -3 dbm is to split the power between the 2 tones at each value of source impedance Z_s which will be defined later.**
c. Modify the Harmonic Balance controller as shown. You should already be familiar with 2 tone setups using a spacing variable similar to the mixer lab for HB TOI. Again, Pavs will be swept and Vcc is the variable that will go out to the dataset for processing. **The Krylov setting is used to speed up the simulation time.**

```
HarmonicBalance
HB1
MaxOrder=4
Freq[1]=RF_freq + spacing/2
Freq[2]=RF_freq - spacing/2
Order[1]=3
Order[2]=3
UseKrylov=yes
SweepVar="Pavs"
Start=-40
Stop=-10
Step=2
Other=OutVar="Vcc"
```

d. The final schematic setup requires two more VAR blocks as shown. These will take a while to type in, but they are very powerful because they allow the load to vary for each harmonic of the source: f1, f2, and f3 are used for testing the value of freq and setting the desired load impedance. **The z_vars (z_fund, z_2, etc.) are used to specify the complex value of impedance at each harmonic. Z_s is for the source.**

```
VAR
Load_Vars
z_fund = 50 + j*0
z_2 = 50 + j*0
z_3 = 50 + j*0
Z_s = 50 + j*0
```

```
NOTE on load z: 50 + j0 is used to demonstrate how the load impedance can be swept using variables and equations. Later, you can vary the value of z by changing 50 to some other value. Or, you could assign more variables that are incremented separately.
```

```
VAR
Freq_vars
f_1 = 1.5 * RF_freq
f_2 = 2.5 * RF_freq
f_3 = 3.5 * RF_freq
load_tuner = if freq<= f_1 then load_fund elseif freq<= f_2 then load_2_harm else load_3_harm endif
load_fund = (z_fund-50) / (z_fund+50)
load_2_harm = (z_2-50) / (z_2+50)
load_3_harm = (z_3-50) / (z_3+50)
```
e. Simulate - then open a new data display and save it as: LNA_2tone.

f. Write two equations for output power of the fundamental tone and the 3rd order tone over the swept input range. Then plot the two equations on one plot with markers as shown.

\[ \text{Eqn} \quad P_{\text{out, fund}} = \text{dBm}(\text{mix}(V_{\text{load}}, \{1.0\})) \]

\[ \text{Eqn} \quad P_{\text{out, 3rd Order}} = \text{dBm}(\text{mix}(V_{\text{load}}, \{2,-1\})) \]

![Fundamental and Third-order Intermod. versus Source Power](image)

```
m1
Pav = -38.000
P_{\text{out, fund}} = -15.858

m2
Pav = -38.000
P_{\text{out, 3rd Order}} = -55.002
```

g. Write an equation to calculate TOI based on the marker positions. The Pav will automatically appear as the independent variable.

\[ \text{Eqn} \quad \text{TOI}_{\text{output}} = 1.5*m1 - 0.5*m2 \]

<table>
<thead>
<tr>
<th>Pav</th>
<th>TOI_{output}</th>
</tr>
</thead>
<tbody>
<tr>
<td>-38.000</td>
<td>3.715</td>
</tr>
</tbody>
</table>
h. Write six equations for power as shown: 1) dc power as Icc probe current times Vcc, 2) Available source power converted to watts needed for the PAE calculation, 3 and 4) load power for both tones using voltage and current at each indexed value, 5) PAE (power added efficiency %) which is power in the two tones at the load minus the available power at the source divided by dc power, and 6) the load power in dBm.

Eqn\(P_{dc} = \text{mag}(I_{cc}[0]) \times V_{cc}[0]\)

Eqn\(P_{\text{avs}_\text{Watts}} = 10^{\text{**}((P_{\text{avs}}-30)/10)}\)

Eqn\(P_{\text{load}1} = 0.5 \times \text{real}(\text{mix}(V_{\text{load}},\{1,0\}) \times \text{conj}(% \text{mix}(I_{\text{load}},\{1,0\})))\)

Eqn\(P_{\text{load}2} = 0.5 \times \text{real}(\text{mix}(V_{\text{load}},\{0,1\}) \times \text{conj}(% \text{mix}(I_{\text{load}},\{0,1\})))\)

Eqn\(\text{PAE} = 100 \times ((P_{\text{load}1}+P_{\text{load}2})-P_{\text{avs}_\text{Watts}})/(P_{dc})\)

Eqn\(P_{\text{load\_dBm}} = 10 \times \log(P_{\text{load}1}+P_{\text{load}2})+30\)

i. Insert two plots as shown to compare PAE vs both load and source power. Plot them using the vs function of the dialog box:
Lab 11: Amplifier Simulations

j. Write and equation for plotting gain of the amplifier vs load power. This equation uses the values from the last set of equations. Put two markers on the trace as shown here – they will be used in the next step.

\[ \text{Eqn } \text{Gain} = \text{Pload}_\text{dBm} - \text{Pavs} \]

Gain versus Load Power

\[ m3 \quad Pload_{\text{dBm}} = -14.742 \quad \text{Gain} = 25.258 \]
\[ m4 \quad Pload_{\text{dBm}} = -1.004 \quad \text{Gain} = 14.996 \]

k. Write two more equations and list their values as shown here. Now, you can set the markers to give values of gain compression various values of load power and gain. Also, the independent value of marker 4 gives you the output power at the gain compression value. Move marker 4 to any desired value of Gain or load power to get another result.

\[ \text{Eqn } \text{GainCompression} = m3 - m4 \]
\[ \text{Eqn } \text{Pout at GainCompression} = \text{indep}(m4) \]

<table>
<thead>
<tr>
<th>GainCompression</th>
<th>[ 10.262 ]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pout at GainCompression</td>
<td>[ -1.004 ]</td>
</tr>
</tbody>
</table>

l. Insert a final plot of bias current vs load power.
8. Perform an ACPR simulation

a. Set up the following new schematic named: ACPR_env

Normally, this type of measurement would be done on a power amplifier but the 900 MHz amp will substitute for now. The CDMA source and the variables are set to the standard CDMA values. Notice that this setup only sends the Vout_fund data to the dataset.

b. Simulate and open a new data display, saved as: ACPR_env.
c. Write an equation for the Vout data in the dataset. Then plot the real part in the time domain as shown here. This will verify that Vout is reasonable.

\[ \text{Eqn} \ V_{\text{fund}} = V_{\text{out\_fund}} \]

Real part of the \( V_{\text{fund}} \) equation is plotted in the time domain.

d. Write two more equations to plot the trajectory as I vs Q. These equations use the \( V_{\text{fund}} \) equation.

\[ \text{Eqn} \ V_{\text{out}} = \text{real}(V_{\text{fund}}) \]
\[ \text{Eqn} \ QV_{\text{out}} = \text{imag}(V_{\text{fund}}) \]

Trace Expression
\[ v s(V_{\text{out}}, IV_{\text{out}}) \]

e. Write one more equation to plot the spectrum using the fs function and the Kaiser window as shown.

\[ \text{Eqn} \ \text{Spectrum} = \text{dBm}(fs(V_{\text{fund}},....,"Kaiser")) \]
f. Write the final equations to calculate the ACPR as shown here. The acpr_vr function requires the arguments listed below. Vfund is the modulated fundamental in the time domain, 50 is the load resistance, the limits are set by the CDMA standard but can be changed as desired, and Kaiser is the windowing function.

The 1.2288 MHz is the CDMA bandwidth for a channel. The 885-915 values are the 30 KHz BW of each adjacent channel.

\[
\text{Eqn } \text{mainlimits} = \{ -(1.2288 \text{ MHz}/2), (1.2288 \text{ MHz}/2) \} \\
\text{Eqn } \text{UpChlimits} = \{ 885 \text{ kHz}, 915 \text{ kHz} \} \\
\text{Eqn } \text{LoChlimits} = \{ -915 \text{ kHz}, -885 \text{ kHz} \} \\
\text{Eqn } \text{TransACPR} = \text{acpr_vr}(\text{Vfund}, 50, \text{mainlimits}, \text{LoChlimits}, \text{UpChlimits}, \text{"Kaiser"})
\]

\[
\begin{array}{|c|c|}
\hline
\text{Lower Channel ACPR} & \text{Upper Channel ACPR} \\
\hline
\text{TransACPR(1)} & \text{TransACPR(2)} \\
8 -63.440 & 8 -65.300 \\
\hline
\end{array}
\]

h. Finally, calculate the power in the channel using the ADS built in function channel_power_vr which returns the value in watts. To do this easily, use ctrl C ctrl V to copy the TransACPR equation and then edit it as shown here. When you list the equation, edit the Trace Expression to convert to dbm: 10 * log (Ch_pwr) + 30.

\[
\text{Eqn } \text{Ch_pwr} = \text{channel\_power\_vr}(\text{Vfund}, 50, \text{mainlimits}, \text{"Kaiser"})
\]

\[
\begin{array}{|c|}
\hline
10 * \log (\text{Ch_pwr}) + 30 \\
8 -14.713 \\
\hline
\end{array}
\]
Information about doing a LOAD PULL simulation

The ADS load pull example sets up a load pull that specifies a visual circular area of the Smith chart where the load is swept. This requires many more equations and complexity than this course teaches. However, if you want to try to perform this simulation on an amplifier, then these steps will be of some help. In any case, you can experiment but remember that this is not a formal part of the course:

- **LOAD PULL - copied from the example directory**

  examples\RF_Board\LoadPull_prj\HB1tone_LoadPull.dsn

  NOTE: The 2 tone is more complicated.

  a. From the Main window – copy the design (HB1Tone_LoadPull.dsn) using the browser into your amplifier directory.

  ![Copy Design Window](image)

  b. Open your new load pull network in the amplifier directory. Then open a data display window. In the data display window, open the example data display for the 1 tone load pull – you will have to go back to that directory to load it. After it opens, use the Save As command to save it into your amplifier directory.

  ![Open Data Display](image)
c. Now you should have everything you need to work on a load pull simulation for your circuit. However, you will have to make changes to the schematic and data display as needed. For example, to simulate a BJT, instead of a FET, you have to make more changes than simply setting voltages and node names.

d. Insert your device and make any changes necessary to the schematic or the data display. If the changes are correct, the red equations in the data display will be black after the appropriate simulation.
EXTRA EXERCISES:

1. Go back to the first step, push down into the BJT_PKG sub-circuit and add 30 fF (femto farads) of base-collector capacitance (Cjc). This will create a realistic situation where parasitics or device feedback causes instability. Now you must redesign the matching networks and complete all the other steps in the lab. This is like repeating the steps with a different device.

2. Use the Large Signal S-parameter Simulation (LSSP) while sweeping Vcc or input power:

   ![LSSP](image_url)

   LSSP
   HB1
   Freq[1]=900 MHz
   Order[1]=7
   LSSP_FreqAtPort[1]=900 MHz
   LSSP_FreqAtPort[2]=900 MHz
   SweepVar="RF_pwr"
   Start=-80
   Stop=0
   Step=10

   LSSP
   HB2
   Freq[1]=900 MHz
   Order[1]=7
   LSSP_FreqAtPort[1]=900 MHz
   LSSP_FreqAtPort[2]=900 MHz
   SweepVar="Vcc"
   Start=0
   Step=10
   Step=0.5

3. Try a topology change when tuning S22 at 900 MHz. The collector gain resistor can be increased in value to get more voltage gain, but you will have to retune the added inductor and the capacitors on the output. Try maximizing the gain by using the optimizer with this change.